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About the Software

Prerequisites

e DirectX 9c or higher from Microsoft
e Flash version 9.0.124.0 or better if you plan to use the 3D Flash wrapper.

Third Dimension Technologies Software
e The camera drivers include the following software components:

@)
@)

USB drivers for the webcams
3D Virtual Camera
e This camera driver will appear in your camera list in most windows
programs.
Camera Connection Wizard
o  Will guide you through verifying that the cameras are attached and the
USB drivers found them.
e  Will guide you through focusing the cameras.
o  Will guide you through the alignment process.
o Wil present the results as anaglyph output and allow you to fine tune the
alignment manually.
3D Camera Sharing
e Start and stop the 3D Virtual Camera first, and it can be shared between
many programs. Without it, you can only use the camera in one
program.
3D Media Center
o “Preview” your 3D camera — This shows your camera output in real time
without the overhead of capturing.
e Open 3D media (video or photo) — Watch 3D videos that you captured or
downloaded from the internet.
e Capture 3D media - Capture video using standard CODECs or Windows
Media Encoder.
o Take a snapshot — During preview or capture you can take an instant
shapshot and save it to disk as a photo.

Optional Components
o K-Lite Codec Pack Basic supports video formats like Flash (FLV), MP4, H264, etc. This is

highly recommended. It includes encoders and decoders. The CODECs enable these
video formats in Windows Media Player.
o Windows Media Encoder Series 9 from Microsoft provides specialized encoding services

including live http streaming and capture to file.



Installation

Driver Setup

Download and launch the installation software. Go through the standard install steps. It is self-
explanatory.

USB Camera Drivers

After all of the files have been installed, you will be presented with the following dialog. If you
have 3D camera choose YES. Without the USB drivers, your 3D Virtual Camera will not
have the ability to connect to the USB devices.

Queston X

\_?(J Basic installation complete, Would you like to install camera drivers now?

Installation Complete

Finally, you have completed the setup process. All of your drivers are installed. You will see the
dialog below. This will launch the Camera Connection Wizard. Be aware that you must go
through the USB Plug and Play process before you can align the cameras. But the
Camera Connection Wizard can run while you are performing that step.

Third Dimension Technologies Drivers - ; - x|

\lj) Camera Connection Wizard will guide you through setting up 3D cameras.

The 3D Camera Sharing tray application will start automatically. Do not start the 3D Camera
sharing until you have successfully completed the Camera Connection Wizard step.




Plug and Play USB Drivers
You must connect ONE CAMERA AT A TIME.

The steps are exactly the same for each USB plug. Make sure you connect one at a time and
complete this step. If you connect both, it can take much longer for Windows to figure out the
devices.

The steps are below. Do them for each USB plug separately. When complete, connect the other
USB plug and repeat the step.

Connect One USB Plug

Connect a USB plug. Windows will recognize that a new device has been connected. This is a
standard process. Each dialog step is shown below. Follow them exactly.

Found New Hardware Wizard

Welcome to the Found New

N '
\? Hardware Wizard

This wizard helps you install software for:
ET USE 2750 Camera

\”\JI if your hardware came with an installation CD
=2 or floppy disk. insert it now.

What do you want the wizard to da?

" Install the software automatically (Recommended)

% Install from a list or specific location {Advanced)

Click Mext to continue.

¢ Back et = Cancel




Found New Hardware Wizard

Please choose your search and installation options.

™ Search for the best driver in these locations.

|se the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[T Search removable media [loppy, CO-REOH...]

¥ Include this location in the seach:

[c:\HP-UPD4_5-PCLE 32 o NN

i Dont search. | will choose the driver to install ;

Choose this option to select the device driver from a list. Windows does not guarartes that
the driver you choose will be the best match for your hardware.

< Back Next > Cancel |

Found New Hardware Wizard

Select the device driver you want to install for this hardware.

i Select the manufacturer and model of your hardware device and then click Mext. f you
= have a disk that contains the driver you want to install, click Have Disk.

W Show compatible hardware

/%, This driver is not digitally signed! Have Disk... |
Tell me driver signing is important

< Back Next > Cancel |

FOR ONE PLUG IT WILL SAY “ET USB 2750” for the other it will say “ET USB 2751”.



Hardware Installation

L] E The saftware you are installing for this hardware:
[
ET USE 2750 Camera

has not passed Windows Logo testing to verfy its compatibility
with Windows ¥P. (Tell me why this testing is importart .}

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

STOF Installation |

CHOOSE CONTINUE ANYWAY

Found New Hardware Wizard

Please wait while the wizard installs the software._ ..

:@ ET USBE 2750 Camera

. j .
msh263.drv
To C:NWINDOW S system32

¢ Back [Ent » Eanzel

Be patient while the files are copied.



Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

= ET USE 2750 Camera
&)

Click Finish to close the wizard.

< Back

Eancel |

DONE!




Software Quick Start Guide

Camera Connection Wizard

If you chose to start the connection wizard, find it on the taskbar and make it the active program.
If not, go to the start menu and it will be listed under “3D Camera”.

The first screen will confirm that the cameras are both connected and functional.

Below is the appearance when the cameras are not found.

)
¢ 4@ Camera Connection Wizard ai 1

Camera Connection Wizard
Task Checklist
[] Check Hardware
[] Focus Left Camera
[] Focus Right Camera

Legend

In Progress
Mot Found
Found 1

[[] Align Cameras

Cameras Mot Found

When all of the devices are found, the application will appear as displayed below. Note that the
Next button is enabled now.

* sl Camera Connection Wizard aogt

Camera Connection Wizard
Task Checklist
Check Hardware
[]Focus Left Camera
[1Focus Right Camera

Legend

In Progress
Mot Found
Found 1

[] Align Cameras

Hardware Check Complete - Ok

Click Next. Focus the left camera. Note the “left” camera is to your right if you are facing the
camera. Left means “left eye view” rather than “your left hand”.
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Camera Connection Wizard
Task Checklist
Check Hardware Focus and Click Next

- ’

[]Focus Left Camera
[ Focus Right Camera

[ Align Cameras

Left Camera

Camera Connected I
\ J

Click Next. Focus the right camera. Note the “right” camera is to your left.

g Camera Connection Wizard ae i

Camera Connection Wizard
Task Checklist
Check Hardware Focus and Click Next

Focus Left Camera — "

[] Focus Right Camera
Right Camera

[ Align Cameras

-

!

Camera Connected i Next I

i

Click Next. Keep the camera steady. Do not hold it in your hands. Find an easily recognizable
point in the distance and click it with the mouse. For example, there is a red dot on the corner of
the shelves in the image below. NOTE: The point you choose should either be the deepest
point in the view, or slightly closer. You will need to experiment based on the depth of
field for your typical scene. Generally you want the convergent point to be behind the
object of interest.
" i@ Camera Connection Wizard : aag}

Camera Connection Wizard

Task Checklist
Check Hardware Camera Alignment
Focus Left Camera

Focus Right Camera

1. Place camera in
steady position.
2. Click farthest point

then Next.
[ Align Cameras

Click farthest point - then Next

Camera Connected Next. ‘

Click Next. The camera image should be frozen. Now, find the exact same point and click it
again with the mouse.



y i — - - i
¢ 8 Camera Connection Wizard X

Camera Connection Wizard
Task Checklist [
Check Hardware Camera Alignment
Focus Left Camera
Focus Right Camera

1. Place camera in
steady position.

2. Click farthest point
then Next.

[l Align Cameras 3. Click same point
= then Next.

Click SAME Point - then Next

Camera Connected ‘

Click Next. The driver now knows the relationship between the left aim and right aim of the

lenses. But, you need to review it. You may need to adjust. The screen will use anaglyph here
because you may not be ready for 3D viewing hardware.

=)
7 g Camera Connection Wizard

a0l
Camera Connection Wizard
Task Checklist o iF
Check Hardware Camera Alignment
Focus Left Camera L
Focus Right Camera

1. Place camera in
steady position.

' 2. Click farthest point
then Next.

Align Cameras 3. Click same point
= then Next.

4. Test alignment.

¥+
*

If image does not focus click Previous and realign.

Manual Alignment

Adjust the alignment. Note that the closer object has blue on the right and red on the left.
Farther objects should be red on the right and blue on the left. You want to adjust it such that
your face, at arms length, has a shadow to the right, but not a huge one. If any objects in the
background have TOO much red to the right, it can become difficult to focus. Put on some
glasses and see what makes you the most comfortable.

Click Finish. .
' Information N

y Camera will always be aligned as shown. Run the wizard again to update alignment.

J
At

You are done. The cameras will always use the alignment that you just produced. Sometimes

refocusing can change the alignment slightly. If you turn them on and they look misaligned, run
through the wizard again.

IF you have 2 cameras, you will need to run the wizard whenever you switch cameras on your
computer. Every camera is different.



3D Camera Sharing

Overview

Sharing allows you to use the 3D Camera with more than 1 program at the same time. Also, the
startup time for the camera is almost instantaneous when sharing is already turned on.

It is recommended that you use the sharing feature whenever using the camera with software
from other vendors. This includes Flash (websites like Youtube), recording software, Skype,
Yahoo, Trillian, etc.

You do not need to use the sharing feature for most of these programs to function properly.
However, some programs are more reliable when sharing is enabled. In particular, Flash
streaming has trouble connecting to the camera on occasion with sharing disabled.

Usage

The image below shows the tray icon for the sharing application. The icon is circled in red. Click
on it to popup a menu, which is shown. The disabled commands will enable when the application
detects the 3D Camera attached and functioning.

Skatt 3nCamers
Show
Setup Camera, . .

! +
Exit 30 Camera Sharing

~ = 143 PM
Bl

Wednesday

ititled - Paint |

“Show” displays a simple dialog with the same commands, but with a video window that displays
the 3D Camera output.

“Setup Camera...” displays a dialog to change the 3D size and format. Once you setup the
format, you do not need to complete this step again. It will remember your settings through
restarts.

Capture Format

Please select video size.

% Large Format [E40:420)
= Small Format [320x240)

Please select 3D capture format.

= Fullcolor Reduced Size (142 Vertical Resalution)

= Anaglyph video chat Red/Cyan [Skype, Wahoo, etc.)

© Anaglyph video chat Blueellow [LCD Skype, *ahoo, ete.)
& Highest quality fullealor - Youtube format [high CPUJ

Ok Cancel

Start and stop the application from either the window or the menu.



3D Camera Sharing

Unfortunately, sharing cannot be started automatically at this time. You must start sharing in the
sharing tray application manually.

Please note that there is a known issue with regard to sharing. If you stop sharing before other
applications have stopped using the shared camera, you may need to restart the sharing
application. In some instances, it will not start the cameras properly. This issue should be
resolved soon.

3D Media Center

Overview

The media center provides a versatile interface for recording, playing, and streaming 3D content.
This document will touch on some of the most commonly utilized features. There are many more
commands worth exploring in the menus.

Also, note that at any time you can right click on the video area and a context aware menu will
popup. This menu provides commands for altering the viewing format, graphics acceleration, etc.

Interface
i¥ 3D Media Center
000000
D O O O O [tum e W o
3D Caméra Flip L.'ﬁgight \ Change  Full Screen
Status Presentation Current  Viewer Type Mode

Viewer Type



View 3D Content

Under the File menu, choose Open or Open URL If the file can be decoded by Windows Media, it
will begin to play. Video recorded by 3D Media Center will automatically set the input 3D format.
For other files, go to the Input Format menu and select the format after the content begins to play.

By default, video is displayed in “best fit” mode. This means that it will fill as much of the video
area as possible. The Size menu has options to set specific sizes.

The View menu has many options. They are logically grouped. First, there is the rendering
choices. This specifies how you will view 3D. There is another group to change the graphics
acceleration.

Record 3D Content

Under the File menu, choose Capture to File. A dialog is presented with capture options. Note
that this application is not intended to be a full featured capture application. For best results use
an application specifically designed for recording content. Simply use the 3D Virtual Camera as
the video source to record in 3D. It is recommended that you use the sharing application when
recording.



